
Direction:
Select the most appropriate option to fill in the blanks.

Question No. 1

One of the most ______ source of indoor air pollution is the allergens. House dust mites (HDM) are very small

insects not _______ to the naked eye and are the commonest source of allergy in the house. They are ubiquitous

and _____ in a warm and moist atmosphere. They _____ very fast and are very difficult to eradicate. Modem

houses present ample breeding spaces for them in the form of carpets, curtains, mattresses, pillows, etc.

Options :

1. important; visible; thrive; breed

2. serious; clear; flourish; cultivate

3. influential; noticeable; bloom; nurture

4. primary; perceptible; grow; propagate

5.

Answer : important; visible; thrive; breed

Question No. 2

Select the most appropriate synonym of the word highlighted in the given sentence.

Learning to manage your emotions is another important part of becoming emotionally and mentally strong.

Options :

1. officiate

2. watch

3. preside

4. handle

5.

Answer : handle
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Question No. 3

Select the most appropriate meaning of the given proverb.

Don’t put too many irons in the fire.

Options :

1. When you make money quickly, it’s very easy to lose it quickly as well.

2. Don’t depend on someone else to do a good job; do it yourself.

3. If you can do something today, do it as soon as possible.

4. Don’t try to do too many things at the same time; focus on one thing at a time.

5.

Answer : Don’t try to do too many things at the same time; focus on one thing at a time.

Direction:
Select the most appropriate option to fill in the blanks. 

Question No. 4

Given the fact that most of us _________ over 90% of our time indoors, it is most important to _______ that the

air we breathe in at home or in offices can be _______. It can be a ______ of illhealth. 

Options :

1. waste; admit; corrupted; basis

2. invest; remember; murky; reason

3. consume; know; contaminated; reason

4. spend; recognise; polluted; cause

5.

Answer : spend; recognise; polluted; cause

Direction:
Select the most appropriate option to fill in the blanks. 

Question No. 5

BSF Head Constable (Ministerial) 2023 Previous Year Paper 18-June-2023 (Shift-1)



You would have seen a/an _______ amount of ‘junk mail’ showing up in your e-mail box. The so-called _____

activities of a small number of people are increasingly becoming a serious problem for the Internet. Spam is the

______ of the e-mail box with many copies of the same message, in an attempt to force the message on people

who would not otherwise ______ to receive it. 

Options :

1. Waxing; inoffensive; downpour; elect

2. Flourishing; trustworthy; deluge; adopt

3. Increasing; harmless; flooding; choose

4. Swelling; powerless; overflow; crave

5.

Answer : Increasing; harmless; flooding; choose

Direction:
Sentences of a paragraph are given below in jumbled order. Arrange the sentences in the correct order to form a
meaningful and coherent paragraph. 

Question No. 6

1) He lay staring at the slowly revolving ceiling fan that picked up dust with each revolution through the hot air.

2) Much later, he rose from the bed and stumbled to the door, rubbing his face with the flat of his palms.

3) As he looked out at the sunlit courtyard with slightly dazed eyes, he saw his mother sway across the red bricks,

carrying a load of freshly washed clothes on one hip and vanish into the stairway leading up to the roof.

4)The day before Abhay shot the white-faced monkey, he awoke to find himself bathed in sweat. 

Options :

1. 2, 3, 1,4

2. 4,1, 2, 3

3. 3, 2, 1, 4

4. 1, 3, 2, 4

5.

Answer : 4,1, 2, 3
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Question No. 7

Select the sentence that does NOT have a spelling error. 

Options :

1. Humidifiers in the air-conditionning plants provide ideal surroundings for certain types of bacteria and

have led to major outbreaks of pnemonia.

2. Humidifiers in the air-conditioning plants provide ideal surroundings for certain types of bacteria and have

led to major outbrakes of pnemonia.

3. Humidifiers in the air-conditioning plants provide ideal surroundings for certain types of bacteria and have

led to major outbreaks of pneumonia.

4. Humidefiers in the air-conditioning plants provide ideal suroundings for certain types of bacteria and have

led to major outbreaks of pneumonia.

5.

Answer : Humidifiers in the air-conditioning plants provide ideal surroundings for certain types of bacteria and have

led to major outbreaks of pneumonia.

Question No. 8

Select the most appropriate synonym of the word highlighted in the given sentence.

Being emotionally and mentally strong, or resilient, means adapting well to things like stress, trauma, adversity or

tragedy.

Options :

1. athletic

2. tough

3. heavy

4. muscular

5.

Answer : tough

Direction:
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Select the most appropriate option to fill in the blanks. 

Question No. 9

Ann Davison had a passion ______ aviation and was among the few Americans to become a pilot. Her marriage to

Frank Davison had _____ her life. They had bought a motorsailer named Reliance. Ann lost her husband ____ a

tragedy with ‘Reliance’. After that, she got a job and a boat ‘Felicity Ann’ which created in her the desire to sail

______ the Atlantic Ocean.

Options :

1. from; changes; on; between

2. in; changed; of; on

3. on; change; in; over

4. for; changed; in; across

5.

Answer : for; changed; in; across

Question No. 10

Select the most appropriate option that can substitute the bold word in the given sentence.

Spamming is basically electronic junk mail or newsgroup posting and the internet is flooded in many copies of the

same message

Options :

1. with

2. into

3. on

4. from

5.

Answer : with

Question No. 11
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Select the most appropriate option that can substitute the bold word in the given sentence.

Simrin cautionary crossed the busy road

Options :

1. cautioners

2. cautiously

3. cautiousness

4. cautioning

5.

Answer : cautiously

Question No. 12

Select the most appropriate ANTONYM of the given word.

Acknowledge

Options :

1. Veto

2. Endorse

3. Acquiesce

4. Ratify

5.

Answer : Veto

Direction:
Sentences of a paragraph are given below in jumbled order. Arrange the sentences in the correct order to form a
meaningful and coherent paragraph. 

Question No. 13

1) By making it essential for life, God has wished that we try to keep the air we breathe clean.

2) But one cannot stop breathing even if one can feel the air to be polluted.
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3) Call it a blessing or a curse of mother nature, we have to breathe in over 10,000 litres of air in a day (more than

four million litres in a year) to remain alive.

4) Everyone can see the food that is not clean and perhaps refrain from eating it

Options :

1. 4, 3, 1, 2

2. 2, 4, 3, 1

3. 1, 2, 3, 4

4. 3, 1, 4, 2

5.

Answer : 3, 1, 4, 2

Question No. 14

 Select the sentence that does NOT have a spelling error.

Options :

1. ‘Passive smoking’ or environmental tobacco smoke pollution can lead to all the harmful effects of tobacco

smoking.

2. ‘Passive smoking’ or enviromental tobaco smoke pollution can lead to all the harmful effects of tobaco

smoking.

3. ‘Passive smokking’ or environmental tobaco smoke polution can lead to all the harmful effects of tobaco

smoking.

4. ‘Passive smocking’ or environmental tobacco smoke polution can lead to all the harmful effects of

tobacco smoking.

5.

Answer : ‘Passive smoking’ or environmental tobacco smoke pollution can lead to all the harmful effects of tobacco

smoking.

Question No. 15
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 Select the sentence that does NOT have a spelling error. 

Options :

1. There are numerous instances of e-mails being used maliciously by someone who has a grudge against a

public official, a former teacher or someone else

2. There are numerous instances of e-mails being used malliciously by someone who has a grudge against a

public official, a former teacher or someone else.

3. There are numerous instances of e-mails being used malleciously by someone who has a grudge against a

public official, a former teacher or someone else.

4. There are numerous instances of e-mails being used malliciouslly by someone who has a grudge against a

public official, a former teacher or someone else.

5.

Answer : There are numerous instances of e-mails being used maliciously by someone who has a grudge against a

public official, a former teacher or someone else

Question No. 16

Select the most appropriate meaning of the given idiom.

Hang in there.

Options :

1. Telling someone not to give up

2. Telling someone to go to sleep

3. Telling someone to calm down

4. Telling someone to start over

5.

Answer : Telling someone not to give up

Direction:
Read the given passage and answer the questions that follow.

Too many parents these days can’t say no. As a result, they find themselves raising ‘children’ who respond greedily

to the advertisements aimed right at them. Even getting what they want doesn’t satisfy some kids; they only want
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more. Now, a growing number of psychologists, educators and parents think it’s time to stop the madness and start

teaching kids about what’s really important: values like hard work, contentment, honesty and compassion. The

struggle to set limits has never been tougher—and the stakes have never been higher. One recent study of adults

who were overindulged as children, paints a discouraging picture of their future: when given too much too soon,

they grow up to be adults who have difficulty coping with life’s disappointments. They also have distorted sense of

entitlement that gets in the way of success in the work place and in relationships.

Psychologists say that parents who overindulge their kids, set them up to be more vulnerable to future anxiety and

depression. Today’s parents themselves raised on values of thrift and self-sacrifice, grew up in a culture where ‘no’

was a household word. Today’s kids want much more, partly because there is so much more to want. The oldest

members of this generation were born in the late 1980s, just as PCs and video games were making their assault’ on

the family room. They think of MP3 players and flat screen TV as essential utilities, and they have developed

strategies to get them. One survey of teenagers found that when they crave for something new, most expect to

ask nine times before their parents give in. By every measure, parents are shelling out record amounts. In the heat

of this buying blitz, even parents who desperately need to say no find themselves reaching for their credit cards.

Today’s parents aren’t equipped to deal with the problem. Many of them, raised in the 1960s and 70s, swore they’d

act differently from their parents and have closer relationships with their own children. Many even wear the same

designer clothes as their kids and listen to the same music. And they work more hours; at the end of a long week,

it’s tempting to buy peace with ‘yes’ and not mar precious family time with conflict. Anxiety about the future is

another factor. How do well intentioned parents say no to all the sports gear and arts and language lessons they

believe will help their kids thrive in an increasingly competitive world? Experts agree: too much love won’t spoil a

child. Too few limits will.

What parents need to find is a balance between the advantages of an affluent society and the critical life lessons

that come from waiting, saving and working hard to achieve goals. That search for balance has to start early.

Children need limits on their behaviour because they feel better and more secure when they live within a secured

structure. Older children learn self-control by watching how others, especially parents act. Learning how to

overcome challenges is essential to becoming a successful adult. Few parents ask kids to do chores. They think their

kids are already overburdened by social and academic pressures. Every individual can be of service to others, and

life has meaning beyond one’s own immediate happiness. That means parents eager to teach values have to take a

long, hard look at their own. 

Question No. 17
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Which of the following can be an appropriate title of the passage?

Options :

1. Challenges of being a modern age parent

2. Today’s teenagers

3. Materialistic needs of children

4. The advantages of an affluent society

5.

Answer : Challenges of being a modern age parent

Direction:
Read the given passage and answer the questions that follow.

Too many parents these days can’t say no. As a result, they find themselves raising ‘children’ who respond greedily

to the advertisements aimed right at them. Even getting what they want doesn’t satisfy some kids; they only want

more. Now, a growing number of psychologists, educators and parents think it’s time to stop the madness and start

teaching kids about what’s really important: values like hard work, contentment, honesty and compassion. The

struggle to set limits has never been tougher—and the stakes have never been higher. One recent study of adults

who were overindulged as children, paints a discouraging picture of their future: when given too much too soon,

they grow up to be adults who have difficulty coping with life’s disappointments. They also have distorted sense of

entitlement that gets in the way of success in the work place and in relationships.

Psychologists say that parents who overindulge their kids, set them up to be more vulnerable to future anxiety and

depression. Today’s parents themselves raised on values of thrift and self-sacrifice, grew up in a culture where ‘no’

was a household word. Today’s kids want much more, partly because there is so much more to want. The oldest

members of this generation were born in the late 1980s, just as PCs and video games were making their assault’ on

the family room. They think of MP3 players and flat screen TV as essential utilities, and they have developed

strategies to get them. One survey of teenagers found that when they crave for something new, most expect to

ask nine times before their parents give in. By every measure, parents are shelling out record amounts. In the heat

of this buying blitz, even parents who desperately need to say no find themselves reaching for their credit cards.

Today’s parents aren’t equipped to deal with the problem. Many of them, raised in the 1960s and 70s, swore they’d

act differently from their parents and have closer relationships with their own children. Many even wear the same

designer clothes as their kids and listen to the same music. And they work more hours; at the end of a long week,

it’s tempting to buy peace with ‘yes’ and not mar precious family time with conflict. Anxiety about the future is
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another factor. How do well intentioned parents say no to all the sports gear and arts and language lessons they

believe will help their kids thrive in an increasingly competitive world? Experts agree: too much love won’t spoil a

child. Too few limits will.

What parents need to find is a balance between the advantages of an affluent society and the critical life lessons

that come from waiting, saving and working hard to achieve goals. That search for balance has to start early.

Children need limits on their behaviour because they feel better and more secure when they live within a secured

structure. Older children learn self-control by watching how others, especially parents act. Learning how to

overcome challenges is essential to becoming a successful adult. Few parents ask kids to do chores. They think their

kids are already overburdened by social and academic pressures. Every individual can be of service to others, and

life has meaning beyond one’s own immediate happiness. That means parents eager to teach values have to take a

long, hard look at their own. 

Question No. 18

 From the options given, choose the ANTONYM of the highlighted word as used in the passage.

What parents need to find, is a balance between the advantages of an affluent society and the critical life lessons

that come from waiting, saving and working hard to achieve goals

Options :

1. Insecurity

2. Anxiety

3. Parity

4. Instability

5.

Answer : Instability

Direction:
Read the given passage and answer the questions that follow.

Too many parents these days can’t say no. As a result, they find themselves raising ‘children’ who respond greedily

to the advertisements aimed right at them. Even getting what they want doesn’t satisfy some kids; they only want

more. Now, a growing number of psychologists, educators and parents think it’s time to stop the madness and start

teaching kids about what’s really important: values like hard work, contentment, honesty and compassion. The
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struggle to set limits has never been tougher—and the stakes have never been higher. One recent study of adults

who were overindulged as children, paints a discouraging picture of their future: when given too much too soon,

they grow up to be adults who have difficulty coping with life’s disappointments. They also have distorted sense of

entitlement that gets in the way of success in the work place and in relationships.

Psychologists say that parents who overindulge their kids, set them up to be more vulnerable to future anxiety and

depression. Today’s parents themselves raised on values of thrift and self-sacrifice, grew up in a culture where ‘no’

was a household word. Today’s kids want much more, partly because there is so much more to want. The oldest

members of this generation were born in the late 1980s, just as PCs and video games were making their assault’ on

the family room. They think of MP3 players and flat screen TV as essential utilities, and they have developed

strategies to get them. One survey of teenagers found that when they crave for something new, most expect to

ask nine times before their parents give in. By every measure, parents are shelling out record amounts. In the heat

of this buying blitz, even parents who desperately need to say no find themselves reaching for their credit cards.

Today’s parents aren’t equipped to deal with the problem. Many of them, raised in the 1960s and 70s, swore they’d

act differently from their parents and have closer relationships with their own children. Many even wear the same

designer clothes as their kids and listen to the same music. And they work more hours; at the end of a long week,

it’s tempting to buy peace with ‘yes’ and not mar precious family time with conflict. Anxiety about the future is

another factor. How do well intentioned parents say no to all the sports gear and arts and language lessons they

believe will help their kids thrive in an increasingly competitive world? Experts agree: too much love won’t spoil a

child. Too few limits will.

What parents need to find is a balance between the advantages of an affluent society and the critical life lessons

that come from waiting, saving and working hard to achieve goals. That search for balance has to start early.

Children need limits on their behaviour because they feel better and more secure when they live within a secured

structure. Older children learn self-control by watching how others, especially parents act. Learning how to

overcome challenges is essential to becoming a successful adult. Few parents ask kids to do chores. They think their

kids are already overburdened by social and academic pressures. Every individual can be of service to others, and

life has meaning beyond one’s own immediate happiness. That means parents eager to teach values have to take a

long, hard look at their own. 

Question No. 19

Identify the tone of the passage. 
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Options :

1. Scheming

2. Forgiving

3. Critical

4. Self-pitying

5.

Answer : Critical

Direction:
Read the given passage and answer the questions that follow.

Too many parents these days can’t say no. As a result, they find themselves raising ‘children’ who respond greedily

to the advertisements aimed right at them. Even getting what they want doesn’t satisfy some kids; they only want

more. Now, a growing number of psychologists, educators and parents think it’s time to stop the madness and start

teaching kids about what’s really important: values like hard work, contentment, honesty and compassion. The

struggle to set limits has never been tougher—and the stakes have never been higher. One recent study of adults

who were overindulged as children, paints a discouraging picture of their future: when given too much too soon,

they grow up to be adults who have difficulty coping with life’s disappointments. They also have distorted sense of

entitlement that gets in the way of success in the work place and in relationships.

Psychologists say that parents who overindulge their kids, set them up to be more vulnerable to future anxiety and

depression. Today’s parents themselves raised on values of thrift and self-sacrifice, grew up in a culture where ‘no’

was a household word. Today’s kids want much more, partly because there is so much more to want. The oldest

members of this generation were born in the late 1980s, just as PCs and video games were making their assault’ on

the family room. They think of MP3 players and flat screen TV as essential utilities, and they have developed

strategies to get them. One survey of teenagers found that when they crave for something new, most expect to

ask nine times before their parents give in. By every measure, parents are shelling out record amounts. In the heat

of this buying blitz, even parents who desperately need to say no find themselves reaching for their credit cards.

Today’s parents aren’t equipped to deal with the problem. Many of them, raised in the 1960s and 70s, swore they’d

act differently from their parents and have closer relationships with their own children. Many even wear the same

designer clothes as their kids and listen to the same music. And they work more hours; at the end of a long week,

it’s tempting to buy peace with ‘yes’ and not mar precious family time with conflict. Anxiety about the future is

another factor. How do well intentioned parents say no to all the sports gear and arts and language lessons they
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believe will help their kids thrive in an increasingly competitive world? Experts agree: too much love won’t spoil a

child. Too few limits will.

What parents need to find is a balance between the advantages of an affluent society and the critical life lessons

that come from waiting, saving and working hard to achieve goals. That search for balance has to start early.

Children need limits on their behaviour because they feel better and more secure when they live within a secured

structure. Older children learn self-control by watching how others, especially parents act. Learning how to

overcome challenges is essential to becoming a successful adult. Few parents ask kids to do chores. They think their

kids are already overburdened by social and academic pressures. Every individual can be of service to others, and

life has meaning beyond one’s own immediate happiness. That means parents eager to teach values have to take a

long, hard look at their own. 

Question No. 20

What do psychologists, educators and parents want to teach the children?

Options :

1. Feel more secure and better

2. Learn how to overcome challenges

3. The values of life like hard work, contentment, honesty and compassion

4. About indiscipline

5.

Answer : The values of life like hard work, contentment, honesty and compassion

Question No. 21

In a certain code language, 'CLASSES' is written as 'VHVVDOF' and 'FORGET' is written as 'WHJURI'. How will

'CUBICAL' be written in that code language? 

Options :

1. ODFLEYF

2. ODGLEXF

3. ODFLEXF
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4. PEFLEXF

5.

Answer : ODFLEXF

Question No. 22

Select the number from the given options which can come in place of the question mark (?) in the following

equation. 

74.96 ÷ 14.998 × 7.007 + 49.009 – 23.005 + 44.98 ÷ 8.99 = ?

Options :

1. 76

2. 66

3. 99

4. 89

5.

Answer : 66

Question No. 23

Select the number from the given options which can come in place of the question mark (?) in the following series. 

14, 29, 59, 119, 239, ?

Options :

1. 488

2. 546

3. 512

4. 479

5.

Answer : 479
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Question No. 24

Select the number from the given options which can come in place of the question mark (?) in the following series. 

27, 29, 34, 44, 61, 87, ?

Options :

1. 124

2. 135

3. 117

4. 110

5.

Answer : 124

Question No. 25

In a class of 58 students, all the students are sitting in a row facing north, Reyansh is sitting 28th from the right end

of the row. Only 17 students are sitting to the left of Garvit. How many students are sitting between Garvit and

Reyansh? 

Options :

1. 14

2. 12

3. 11

4. 13

5.

Answer : 12

Question No. 26

Select the correct combination of letters from the options which when placed sequentially in the blank spaces of

the series given below, will complete the series. 
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T_NU_W_YN_R_TY_URW

Options :

1. YTNUWN

2. YRTUWN

3. YRTUWY

4. YRTNWN

5.

Answer : YRTUWN

Question No. 27

Which two numbers should be interchanged to make the following equation correct? 

13 × 4 + 48 ÷  8 – 27 = 101

Options :

1. 13 and 27

2. 13 and 8

3. 27 and 48

4. 4 and 8

5.

Answer : 13 and 27

Direction:
Read the given statements and course of actions carefully. Considering all the things given in the statement to be
completely true, decide which of the suggested actions (decision to be taken for follow-up/correction regarding the
problem) should be adopted in its regard? 

Question No. 28

Statement:

The number of complaints lodged by patients and their attendants in Hospital-A has increased during the last five

years. Due to insufficient number of doctors available to treat the increasing number of patients, one has to wait
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for hours for treatment to start. 

Course of Actions:

I. More doctors should be recruited in the hospital to meet the needs of the increasing number of patients.

II. To reduce the number of complaints, patients should be motivated not to report any case of complaint. 

Options :

1. Both course of actions I and II should be taken

2. Only course of action I should be adopted

3. Neither course of action I nor action II should be taken

4. Only course of action II should be adopted

5.

Answer : Only course of action I should be adopted

Question No. 29

The following figures show the sequence of folding a transparent sheet of paper and the method of cutting the

folded paper. What will this paper look like when opened? 
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Options :

1. 1

2. 2

3. 3

4. 4

5.

Answer : 4

Question No. 30

Select the option which is related to the fifth letter-cluster in the same way as the second letter-cluster is related

to the first letter-cluster and the fourth letter-cluster is related to the third letter-cluster. 

PLAY : QNDC :: SIGN : TKJR :: COMB : ?
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Options :

1. DQPG

2. DQQF

3. DQPF

4. DQPE

5.

Answer : DQPF

Question No. 31

A unique number has been assigned to each letter in the following table. Select such a combination of numbers

which when arranged according to the letters will form a meaningful word. 

Options :

1. 2, 5, 6, 3, 4, 1, 9, 8, 7

2. 2, 5, 3, 6, 4, 1, 9, 8, 7

3. 2, 5, 6, 3, 4, 1, 9, 7, 8

4. 2, 5, 6, 3, 4, 9, 1, 8, 7

5.

Answer : 2, 5, 6, 3, 4, 1, 9, 8, 7

Question No. 32

Select the figure that will come next in the following figure-series.  
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Options :

1. 1

2. 2

3. 3

4. 4

5.

Answer : 3

Question No. 33

Select the option in which the figure given below is embedded. (Rotation of the shape is not allowed) 
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Options :

1. 1

2. 2

3. 3

4. 4

5.

Answer : 1

Question No. 34

If P > U > M = E > H = F

Options :

1. C > H

2. M < P
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3. F > M

4. U > E

5.

Answer : F &gt; M

Question No. 35

Four letter-clusters have been given, out of which three are consistent with each other in some manner while one

is inconsistent with them. Select the odd letter group. 

Options :

1. MQUYC

2. TXBFJ

3. GKOSX

4. NRVZD

5.

Answer : GKOSX

Question No. 36

Shown below are two different positions of the same dice, whose six faces are marked with numbers from 1 to 6.

Select the number which will be on the face opposite to the face marked '5'. 

Options :

1. 2

2. 4

3. 3

4. 6
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5.

Answer : 6

Question No. 37

Select the correct mirror image of the given combination when the mirror is placed on 'PQ' as follows. 

Options :

1. 1

2. 2

3. 3

4. 4

5.

Answer : 1

Question No. 38

Select the figure that will come next in the following figure-series. 
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Options :

1. 1

2. 2

3. 3

4. 4

5.

Answer : 3

Question No. 39

Statement:

All crackers are toys.

Some crackers are rockets.

All rockets are aeroplanes.
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Conclusion:

I. Some toys are aeroplanes.

II. Some rockets are toys.

III. No toy is aeroplane.

Options :

1. Only II follows

2. Only I and III follow

3. Only II and III follow

4. Only I and II follow

5.

Answer : Only I and II follow

Question No. 40

In a certain code language, 'FOXES' is written as '138' and 'TIMED' is written as '102'. How will 'FOUND' be written in

that code language? 

Options :

1. 110

2. 140

3. 120

4. 135

5.

Answer : 120

Question No. 41

At a simple interest rate of 12.5% ​​per annum, a sum amounts to ₹17,187.50 in 3 years. What is the amount? 

Options :

1. ₹10,600
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2. ₹13,200

3. ₹12,500

4. ₹11,800

5.

Answer : ₹12,500

Question No. 42

28 men can complete a work in 36 days. In how many days will 18 men complete the same work? 

Options :

1. 56

2. 58

3. 52

4. 60

5.

Answer : 56

Question No. 43

A shopkeeper sells 250 g less for every kg of wheat and earns a profit of 54%. If he had sold the wheat correctly,

while the selling price remained the same, what would have been his profit percentage? 

Options :

1. 16%

2. 15.5%

3. 14.5%

4. 15%

5.

Answer : 15.5%
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Question No. 44

In the figure shown below, AO = CD, where point O is the center of the circle. What is m∠APB? 

Options :

1. 30°

2. 50°

3. 60°

4. 45°

5.

Answer : 60°

Question No. 45

Two men and a woman can complete a certain work in 16 days, while 3 men and 2 women can complete the same

work in 10 days. In how many days will 10 women complete the same work? 

Options :

1. 8

2. 4

3. 5

4. 6

5.

Answer : 8
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Question No. 46

In a 20 over match, the average runs scored by a team in different sessions of the innings are given below. Find the

average runs scored by the team in that entire innings.

From first to fifth over: 8 runs per over

From 6th to 15th over: 5 runs per over

16th to 20th over: 10 runs per over

Options :

1. 6

2. 8

3. 7

4. 5

5.

Answer : 7

Question No. 47

A farmer planned to control pests in his crop to increase the yield. He took a loan of ₹ 5,000 at a fixed annual

interest rate for 2 years, compounded annually. He paid interest of ₹ 1,272. What was the annual interest rate? 

Options :

1. 10%

2. 15%

3. 12%

4. 5%

5.

Answer : 12%

Question No. 48
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A, B and C. start a business with investment in the ratio 3 : 4 : 5. After 4 months, A doubles the investment. B

reduces the investment to 3/4 and C does not change his investment. At the end of year 4, a profit of ₹58,900 is

earned. What is B's share in profit? 

Options :

1. ₹14,725

2. ₹14,484

3. ₹14,275

4. ₹14,525

5.

Answer : ₹14,725

Question No. 49

In a series of cricket matches, a cricketer scores 79 runs in his 18th innings and his average score increases by 4.

What is the average of 18 innings?

Options :

1. 7

2. 16

3. 11

4. 15

5.

Answer : 11

Question No. 50

The ratio of the number of men and women working in an office is 9 : 7. If the number of men working in the office

is 153, then find the number of women working in the office. 

Options :

1. 139
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2. 129

3. 119

4. 149

5.

Answer : 119

Direction:
Study the following table and answer the question that follows. 

Question No. 51

Find the ratio of the average production of cars of all companies in 1995 to the average production of H cars in 1985,

2005 and 2015. 

Options :

1. 60 : 57

2. 60 : 59

3. 59 : 60

4. 57 : 60

5.

Answer : 60 : 59

Question No. 52

In a race, A beats B by 35 seconds and B beats C by 45 seconds. The speed of B is the average of the speed of A and

C. What is the time (in minutes) taken by C to complete the race? 
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Options :

1. 5(1/3)

2. 5

3. 6(1/2)

4. 6

5.

Answer : 6

Question No. 53

If x – y = 9 and xy = 7, then what is the value of x³ – y³ – 8 (x + y)²? 

Options :

1. 46

2. 51

3. 48

4. 41

5.

Answer : 46

Question No. 54

Pipes A and B can fill a tank in 12 hours and 20 hours respectively. The pipe is an emptying pipe. If A, B and C are

opened together for 8 hours, 80% of the tank is filled. Initially, pipe B is opened for 4 hours and then it is closed.

Pipes A and C together will fill the remaining part of the tank in _________. 

Options :

1. 12 hours

2. 15 hours

3. 18 hours

4. 16 hours
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5.

Answer : 16 hours

Direction:
The following pie chart shows the salary, expenditure and savings of Rafi and Mamta. 

 

Question No. 55

What is the ratio of Rafi's expenditure on entertainment to Mamta's savings?  

Options :

1. 11 : 9

2. 8 :11

3. 1 : 8

4. 9 : 11

5.

Answer : 1 : 8

Question No. 56

Find the volume of a cone whose radius is 15 cm and slant height is 25 cm.  

Options :

1. 1500π

2. 1787π
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3. 1556π

4. 1278π

5.

Answer : 1500π

Question No. 57

If a number is increased by 15% and then decreased by 12%, the resulting number is 526.24. Find the original

number.  

Options :

1. 560

2. 530

3. 540

4. 520

5.

Answer : 520

Question No. 58

In a contest between two candidates, 10% of the total voters did not cast their vote and 10% of the votes cast

were declared invalid. The winning candidate received 52% of the valid votes and won by 243 votes. Find the

number of votes cast. 

Options :

1. 7500

2. 7200

3. 6480

4. 6750

5.

Answer : 6750
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Question No. 59

If in ∆ABC the orthocentre, centroid, incentre and circumcentre coincide with each other and if the length of one of

its sides is √27 units, then the altitude passing through vertex A will be ______. 

Options :

1. 5.5 Unit

2. 4.5 Unit

3. 3.5 Unit

4. 4.8 Unit

5.

Answer : 4.5 Unit

Direction:

Simplify the questions: 

Question No. 60

Options :

1. 0.41

2. 1.41

3. 1.014

4. 0.041

5.

Answer : 0.41

Question No. 61

Match the columns. 
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Options :

1. a-iv, b-iii, c-i, d-ii

2. a-ii, b-iii, c-iv, d-i

3. a-ii, b-iv, c-iii, d-i

4. a-iii, b-ii, c-iv, d-i

5.

Answer : a-ii, b-iii, c-iv, d-i

Question No. 62

Which of the following keyboard shortcuts is used to copy content to the clipboard?  

Options :

1. Ctrl + A

2. Ctrl + V

3. Ctrl + F

4. Ctrl + C

5.

Answer : Ctrl + C
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Question No. 63

MS Word 365 Clipboard allows us to copy up to __________. 

Options :

1. 12 items

2. 16 items

3. 20 items

4. 24 items

5.

Answer : 24 items

Question No. 64

Vacuum tube is the specialty of which generation computer? 

Options :

1. second generation computers

2. first generation computers

3. third generation computers

4. fourth generation computers

5.

Answer : first generation computers

Question No. 65

Match columns: 
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Options :

1. a-ii, b-iv, c-iii, d-i

2. a-iv, b-iii, c-i, d-ii

3. a-ii, b-iii, c-iv, d-i

4. a-iii, b-ii, c-iv, d-i

5.

Answer : a-ii, b-iii, c-iv, d-i

Question No. 66

Which of the following symbols refers to programs, applications, or shortcuts to an item, file, or program on a

computer in Windows XP? 

Options :

1. Task bar

2. icon

3. Path

4. Start button

5.

Answer : icon

Question No. 67

Identify the true or false statements given below.
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i) An assembler is a program that converts instructions written in low-label assembly code into machine code. 

ii) An assembler converts assembly code into machine code line by line.

iii) Different types of assemblers include one-pass assemblers and load-and-go assemblers. 

Options :

1. i-true, ii-false, iii-true

2. i-false, ii-false, iii-true

3. i-true, ii-true, iii-true

4. i-true, ii-true, iii-false

5.

Answer : i-true, ii-true, iii-true

Question No. 68

Identify the true or false statements given below. 

i) The 'Task Bar' is the thin blue bar at the bottom of the desktop and contains the Start menu and Quick Launch bar

on the Windows XP desktop.

ii) The notification area is a part of the taskbar that provides a temporary source for notifications and status.

iii) Control Panel in Microsoft Windows XP is used to configure system level features and perform related tasks. 

Options :

1. i-right, ii-right, iii-wrong

2. i-right, ii-right, iii-right

3. i-right, ii-wrong, iii-right

4. i-wrong, ii-right, iii-right

5.

Answer : i-right, ii-right, iii-right

Question No. 69
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Select the incorrect statement. 

Options :

1. To start checking spelling and grammar in your MS Word 365 document, simply press F7.

2. The icon on the Review tab in MS Word 365 is a spelling and grammar checker icon.

3. To change AutoCorrect settings in MS Word, go to View > Window -> Split.

4. By using thesaurus feature in MS Word 365 we can find synonyms and antonyms.

5.

Answer : To change AutoCorrect settings in MS Word, go to View &gt; Window -&gt; Split.

Question No. 70

The keyboard shortcuts for 'Navigation' and 'Find and Replace' in MS Word are _________ and ________

respectively. 

Options :

1. Ctrl + N, Ctrl + R

2. Ctrl + N, Ctrl + H

3. Ctrl + F, Ctrl + H

4. Ctrl + F, Ctrl + A

5.

Answer : Ctrl + F, Ctrl + H

Question No. 71

Identify the true or false statement in the following

i) COUNT_NONE_BLANK function in MS Excel 365 returns the number of cells in the selected range that contain

text or values, but do not contain blank cells.

ii) In MS Excel 365, CHOOSE function is under lookup and reference.

iii) In MS Excel 365, a bar chart shows comparisons between different items.

BSF Head Constable (Ministerial) 2023 Previous Year Paper 18-June-2023 (Shift-1)



Options :

1. i-false, ii-true, iii- true

2. i- true, ii-false, iii- true

3. i-true, ii- true, iii- true

4. i- true, ii- true, iii- false

5.

Answer : i-false, ii-true, iii- true

Question No. 72

Match the columns.

Options :

1. a-ii, b-iv, c-iii, d-i

2. a-iii, b-ii, c-iv, d-i

3. a-ii, b-iii, c-iv, d-i

4. a-iv, b-iii, c-i, d-ii

5.

Answer : a-ii, b-iii, c-iv, d-i
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Question No. 73

A _____ masks your IP address by redirecting the network through a specially configured remote server run by the

VPN host. 

Options :

1. virtual private network

2. global area network

3. private area network

4. metropolitan area network

5.

Answer : virtual private network

Question No. 74

Match the columns: 

Options :

1. a-iii, b-ii, c-iv, d-i

2. a-ii, b-iii, c-i, d-iv

3. a-ii, b-iii, c-iv, d-i

4. a-ii, b-iv, c-iii, d-i

5.
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Answer : a-ii, b-iii, c-iv, d-i

Question No. 75

Which of the following programs helps to manage files and folders in Windows XP? 

i-Windows File Explorer

ii-Internet browser

iii-Help

iv Program files

Options :

1. Only i and ii

2. Only iii

3. Only i

4. Only i and iii

5.

Answer : Only i

Question No. 76

Match the columns. 

Options :

1. a-iii, b-ii, c-iv, d-i

2. a-ii, b-iii, c-iv, d-i
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3. a-ii, b-iv, c-iii, d-i

4. a-iv, b-iii, c-i, d-ii

5.

Answer : a-ii, b-iii, c-iv, d-i

Question No. 77

In MS Excel 365, which of the following options is/are correct for naming the worksheet?

i) The name of a worksheet can contain more than 31 characters.

ii) The name of a worksheet can contain any of the following characters: / \ ? ,

iii) The worksheet can be named 'History'.

iv) The worksheet can be named 'Abcd1001'.

Options :

1. Only (ii) and (iii)

2. Only (iv)

3. Only (iii) and (iv)

4. Only (i), (iii) and (iv)

5.

Answer : Only (iv)

Question No. 78

Identify the true or false statements given below.

i) Asymmetrical Digital Subscriber Line (ADSL) and Symmetrical Digital Subscriber Line (SDSL), these are types of

DSL transmission technologies.

ii) Internet Information Server (IIS) is a high performance web server from Microsoft.

iii) Web server is a computer where web content is stored.
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Options :

1. i- correct, ii- correct, iii- correct

2. i- correct, ii-wrong, iii- correct

3. i- wrong, ii- right, iii- right

4. i- correct, ii- correct, iii- wrong

5.

Answer : i- correct, ii- correct, iii- correct

Question No. 79

Which of the following options is used to save the file in CSV format in MS Excel 365?  

Options :

1. Save

2. Save As

3. Publish

4. Create

5.

Answer : Save As

Question No. 80

Match the columns:

Options :
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1. a-ii, b-iv, c-iii, d-i

2. a-ii, b-iii, c-iv, d-i

3. a-iv, b-iii, c-i, d-ii

4. a-iii, b-ii, c-iv, d-i

5.

Answer : a-ii, b-iii, c-iv, d-i

Question No. 81

Select the number from the given options which will come in place of the question mark (?) in the following series. 

12, 17, 32, 77,?

Options :

1. 208

2. 215

3. 210

4. 212

5.

Answer : 212

Question No. 82

Following the word given in the question, four more words are given in the options, one of which cannot be

formed using the letters of the word given in the question only once. Identify that word. 

CONSANGUINEOUS 

Options :

1. Enouncing

2. Conscience

3. Cousinage

4. Canonises
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5.

Answer : Conscience

Question No. 83

Identify the wrong number in the series given below. 

22 120 338 724 1324 2192 

Options :

1. 2192

2. 338

3. 1324

4. 120

5.

Answer : 1324

Question No. 84

The minister agreed to acsept our invitation for the fashion show.

Options :

1. minster

2. accept

3. faishion

4. invitashion

5.

Answer : accept

Question No. 85

Select the misspelled word. 
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Options :

1. Recieve

2. Necessity

3. Fruitful

4. Visionary

5.

Answer : Recieve

Question No. 86

The Kiwi fruit/doesn't tastes very good/but it seems that / it is quite nutritious.

Options :

1. The Kiwi fruit

2. doesn't tastes very good

3. but it seems that

4. it is quite nutritious

5.

Answer : doesn&#039;t tastes very good

Question No. 87

If the currency of UAE is Dirham, then which is the currency of Myanmar? 

Options :

1. Kyat

2. peso

3. won

4. euro

5.

Answer : Kyat
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Question No. 88

From the given options, select the alphanumeric group which will come in place of the question mark (?) in the

following series. 

S77, U52, X32, ?, J7, U2

Options :

1. B17

2. C18

3. C17

4. C20

5.

Answer : C17

Question No. 89

Select the option which is related to the third word in the same way as the second word is related to the first

word. 

Tennis Court :: Race : ? 

Options :

1. pitch

2. cap

3. track

4. Horse

5.

Answer : track

Question No. 90

The following sentence is divided into four sections. Identify the section that contains a grammatical error. 
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1) India is highly vulnerable

2) to seismic hazards

3) due to its increasing population

4) and extensive unscientific construct.

Options :

1. 1

2. 3

3. 4

4. 2

5.

Answer : 4

Question No. 91

Answer the question given below on the basis of the given number and symbol series. 

(Left) 3% $ 7 2 5 $ 1 & 6 # * 3 9 ! 4 3 @ S 8 (right) 

How many such symbols are there in the above series (from left to right), which are immediately preceded by a

symbol and immediately followed by an even number?

Options :

1. 2

2. 1

3. 4

4. 3

5.

Answer : 1

Question No. 92
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From the given options, select the alphanumeric group which will come in place of the question mark (?) in the

following series. 

D76, G68, M58, V44, ? 

Options :

1. G24

2. H24

3. H26

4. G26

5.

Answer : H24

Question No. 93

Choose the most appropriate synonym of the given word. 

AFFLUENT

Options :

1. Sporadic

2. Pompous

3. Prosperous

4. Narcissistic

5.

Answer : Prosperous

Question No. 94

Read the given statements and conclusions carefully. Assuming that the information given in the statements is true

even if it seems to be at variance from commonly known facts, decide which of the given conclusions logically

follows from the statements. .
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Statement:

The prices of fruits are skyrocketing in the market.

Conclusion: 

1. Fruits are becoming a rare commodity.  

2. People can't eat fruits.

Options :

1. Neither conclusion follows.

2. Only conclusion 2 follows.

3. Only conclusion 1 follows.

4. Both conclusions 1 and 2 follow.

5.

Answer : Neither conclusion follows.

Question No. 95

Select the number from the given alternatives that can replace the question mark (?) in the following series. 

38, 36, 32, 30, 26, ? 

Options :

1. 24

2. 18

3. 22

4. 20

5.

Answer : 24

Question No. 96
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Arrange the following words in their meaningful order according to the dictionary. 

1. Epicanthus, epicardial, epicardium, epicalyses 

2. Epicalyses, epicanthus, epicardial, epicardium

3. Epicalyses, epicanthus, epicardium, epicardial

4. Epicardial, epicalyses, epicanthus, epicardium

Options :

1. 1

2. 2

3. 4

4. 3

5.

Answer : 2

Question No. 97

I did not finish the book because the story was trite and drab.

Options :

1. Hackneyed

2. Sharp

3. Illogical

4. Long

5.

Answer : Hackneyed

Question No. 98

In a certain code language, 'TRUCK' is written as 'UQVBL'. How will 'STAND' be written in that code language?  
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Options :

1. TSCME

2. TTBME

3. TSBNE

4. TSBME

5.

Answer : TSBME

Question No. 99

Select the option that shows the correct arrangement of the given words in the order in which they appear in the

English dictionary. 

1. Casino

2. Case

3. Casuals

4. Cast

5. Cash

6. Cashier

Options :

1. 2, 5, 6, 4, 1, 3

2. 2, 5, 6, 1, 3, 4

3. 2, 5, 6, 1, 4, 3

4. 2, 5, 1, 6, 4, 3

5.

Answer : 2, 5, 6, 1, 4, 3

Direction:
Read the given statements and conclusions carefully. Assuming that the information given in the statements is true,
even if it seems to be at variance from commonly known facts, decide which of the given conclusions logically
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follows from the statements. 

Question No. 100

Statement:

A. All germanium is lithium.

B. Some deuteron are plumbum.

C. Some germanium is chlorine.

Conclusion:

(I) Some lithium are deuteron.

(II) Some germanium are plumbum.

(III) Some Lithium are Chlorine. 

Options :

1. Only conclusion I follows

2. Only conclusion II follows

3. Only conclusion III follows

4. none of the conclusions follow

5.

Answer : Only conclusion II follows
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